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Introduction

Chapter 1 Introduction

Congratulations on becoming an owner of the
Samsung External Hard Disk Drive with SecretZone.
You made an excellent choice and we hope you will
enjoy all its capabilities.

SecretZone allows you to create multiple virtual drives
on the Samsung External Hard Disk Drive.

Samsung’s SecretZone protects important files and
data in the form of software-based 128-bit AES, 256-
bit AES, and Blowfish 448 encryption. The external
drive owner's data is also locked with a password
which ensures data security. In addition to the
freedom of knowing that your data is secure, you can
transfer your secured data from one Samsung
External Hard Disk Drive to another. No more
transporting information on a memory stick that can
be easily lost, stolen, or misplaced.

Samsung SecretZone User Manual Ver 2.0
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Introduction

NOTE: PLEASE READ AND UNDERSTAND THE
COMPLETE CONTENTS OF THIS MANUAL.
THE CONTENTS OF THIS MANUAL MAY BE

MODIFIED WITHOUT PRIOR NOTICE.

Inquiries Clarus, Inc. Homepage
http://www.clarussoft.com/
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Introduction

Handling Precautions

The following are precautions that must be
followed to enjoy a long Samsung External Hard
Disk Drive life.

NOTE: PLEASE READ AND UNDERSTAND ALL
THE FOLLOWING PRECAUTIONS BEFORE
PROCEEDING TO USE TOUR SAMSUNG
EXTERNAL HARD DISK DRIVE

Regular Virus Scanning

Frequently scan the device for viruses and
protect the device from virus infection.

Safely Remove Hardware

Always use the Safely Remove Hardware
feature before shutting down the Samsung
External Hard Disk Drive or disconnecting the
USB cable.

Samsung SecretZone User Manual Ver 2.0
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Terms and concepts

Chapter 2 Terms and
Concepts
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Terms and concepts

Idle Timeout
As long as the Samsung External Hard Disk
Drive is receiving input or doing a task, the
drive is 'active'. When there is no activity for a
set period of time, the drive becomes 'inactive'.
When the drive is 'inactive' it is called 'Idle’
and the drive will come to a 'rest'. You set the
'Idle Timeout' to start when there has been no
activity for a period of time by entering a time
in this field. For instance, if you want the drive
to rest if there has been no activity for 10
minutes, you would enter a '10" in the Idle
Timeout field. After 10 minutes of inactivity,
the drive would come to a rest until it detects
activity again.

Partition
Most operating systems, such as Windows NT
or Windows XP, allow users to divide a hard
disk into multiple partitions, in effect making
one physical hard disk into several smaller
logical hard disks.
There are many reasons to partition a hard
drive but the most widely used is to have one
partition that contains all of the programs and
one partition that contain all the data. Using
this type of partitioning makes backing up your
data much easier since it is all contained on
one partition. As well, if the operating system
has any problems, it is much easier to format
and reinstall the operating system.
Partitions are identified by a drive alpha name
like the "C" drive or the "G" drive.

File Systems
A File System is how the computer keeps track

of where all the files are on the disk. Like a
Table of Contents, the File System on a

Samsung SecretZone User Manual Ver 2.0
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Terms and concepts

computer is referenced whenever you look for,
or write to, a file Types of File Systems are
FAT16, FAT32, and NTFS. The following will
give a brief explanation of each Filing System's
Pros, Cons, and the primary audience for the
File System.

FAT16

FAT is an abbreviation for File Allocation Table.
The FAT file system is straightforward and is
supported by most existing operating systems
for personal computers. This makes it an ideal
format for solid-state memory cards and a
convenient way to share data between
operating systems.

TABLE 1. Pros and Cons of FAT16

Pros Cons Used Mostly For:
Can read/write on It you lose power while Non-IT
most operating working, you may environments. More
. corrupt the FAT and you )
systems (Windows take a chance of losin for home or
and Macintosh). g individual use.

File transfer using a
disk is more probable
since file sizes must
be smaller than with
NTFS

your data.

Can only be partitioned
up to 2 gigabytes.

Samsung SecretZone User Manual Ver 2.0
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FAT32
FAT32 is used to create much larger partitions
than what you can with FAT16.

NOTE: FOR THE SAMSUNG SECRETZONE,
THE MAXIMUM FILE SIZE IS 2 GIGABYTES.

TABLE 2. Pros and Cons of FAT32

Pros Cons Used Mostly For:
Can read/write on Can only handle files up to Non-IT
most operating 4 Gigabytes environments.
systems More for home or
individual use
Partitions can be as Partitions using a Windows

large as 2 Terabytes operating system can only
be as large as 32 gigabytes

File transfer using a If you lose power while
disk is probable since = working, you may corrupt

file sizes must be the FAT and you take a
smaller than with chance of losing your data
NTFS

NOTE: THE FAT32 FILE SYSTEM LIMITS THE
SIZE OF ANY FILE ON THE DRIVETO A
MAXIMUM OF 4GB. TO ENSURE RELIABLE
OPERATION UNDER FAT32, SECRETZONE
LIMITS EACH VIRTUAL DRIVE'SSIZE TO A
MAXIMUM OF 2GB. WINDOWS PC OWNERS
WHO WISH TO UTILIZE CAPACITY
GREATER THAN 2GB SHOULD REFORMAT
THEIR EXTERNAL SAMSUNG DRIVE TO
NTFS IN THE WINDOWS OPERATING
SYSTEM

Samsung SecretZone User Manual Ver 2.0
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Terms and concepts

NTFS

NTFS is an abbreviation for Windows NT File
System or is sometimes called New Technology
File System. If you are familiar with using
paper files, the same concept applies here.
NTFS is the way in which the operating system
(Windows NT, XP, etc) organizes the files on
the drive. NTFS is quite secure and robust. It
provides security by supporting access control
and ownership privileges, meaning you can set
permission for groups or individual users to
access certain files.

TABLE 3. Pros and Cons of NTFS

Pros Cons Used Mostly For:
Very secure. You can  No file system checker ~ Users with a
setup groups with or deframentation professional IT
different permissions  option administrator
to different files
Can support files up There is no way to Applications require
to 4 gigabytes retrieve user data if files over 4 gigabytes

accidently erased

Can maintain file Limited maintenance Partition/Hard Drive
system for partitions  tools is more than 137
or drives that are 137 gigabytes

gigabytes and larger

Volume

A drive Volume is simply the name that you
give to a partition. It is often referred to as the
Volume Name. So, let's say that you have two
partitions; one is for your programs and one is
for your data. The partition for your programs
may be called PROGRAMS C:. The drives
volume name is then PROGRAMS C.:.

Samsung SecretZone User Manual Ver 2.0
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Volume Image
The Volume Image is the contents of the
volume. So the Programs C: volume contains
all of your programs. The Image of that volume
would be all of your programs.

Virtual Drive

A virtual drive is a part of the whole drive. So,
for instance, if you create a new Volume and
name it the "G" drive, that has now become a
virtual drive. Since the whole Hard Disk Drive
is also called a drive, when you create a
partition you also call that a drive - but it is not
the whole Hard Disk Drive, it is only a part (or
volume) on the Hard Disk Drive. So, just as a
room in your house is not the whole house, a
virtual drive on a Hard Disk Drive is not the
whole drive.

Samsung SecretZone User Manual Ver 2.0
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Installing the Software

Chapter 3 Installing the
Software
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Installing the Software

Introduction

Samsung SecretZone is a software program that
runs in the MS windows environment and
protects personal information.

If you want to keep private information or other
important information from others, including
your colleagues at work and your family
members, or if you want to move your data to a
different location, you can use the Samsung
SecretZone, the secure, perfect solution to do
these tasks easily and conveniently.

You can think of Samsung SecretZone as a safe
within your computer, and store your important
data in the safe.

Samsung SecretZone User Manual Ver 2.0
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Before Installation

Samsung SecretZone is a software program that
runs in the Microsoft Windows environment and
protects personal, private information.

If you want to keep private information private -
important information unreadable to others -
keep your sensitive data with you at all times -
you can use the SecretZone™ program provided
on the sleek Samsung External Hard Disk Drive.
Have the confidence that your data is secured
using software-based 128-bit AES, 256-bit AES,
or Blowfish 448 encryption. You can think of
Samsung SecretZone as a safe within your
computer.

Samsung SecretZone User Manual Ver 2.0
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Preparing your Computer

We recommend that you check the current
condition of your computer and take any
necessary measures to optimize or defragment
it before using this software.

For help with optimizing and defragmenting
your computer, please see the manufacturer's
recommendations.

If your system is unstable, for example if it
displays blue screens, you encounter an error
message while booting the system, or crashes
frequently in everyday use, you must resolve
these problems before using this software. If
you think your system is stable, optimize it
anyway by running the recommended
optimizing software before using this software.

System Requirements
The following is the minimum system
specifications for Samsung SecretZone:

TABLE 1. Minimum System Requirements

Component Minimum Specification

CPU Intel® Pentium® equivalent 1GHz

MEMORY 512 MB

HDD 500 MB

Operating System Microsoft Windows® XP SP2 or
Windows Vista™ or Windows 7
(32-bitonly)

Web Browser Microsoft Windows® Internet

Explorer® 5.5

Samsung SecretZone User Manual Ver 2.0
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Connecting the Drive to Your Computer

Contained in the packaging is a USB cable. The
smallest end of the cable plugs into the
Samsung External Hard Disk Drive and the
larger end plugs into your Computer. This is
keyed so you can only plug it in one way.

Figure 3-1 Connecting your External drive to your Computer

LED

Connect to
Computer

Connect to Samsung
External Hard Disk Drive

Samsung SecretZone User Manual Ver 2.0
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Installing the Software

When you connect the Samsung External Hard
Disk Drive to your computer, there is a short
pause. After the pause, the Welcome screen
appears.

Welcome message

The first screen is the Welcome Screen. To
continue on to the installation:

1. Click Install Samsung SecretZone

Figure 3-2 Samsung SecretZone Install Wizard Welcome

Samsung _
externa HDD!

SoftWare

’ Install Samsung Auto Backup

% Install Samsung SecretZone

mi Read User's Manual -3

Install SecretZone that can safely manage private data,

like as the safe. B

NOTE: WHEN YOU INSTALL THE
SECRETZONE PROGRAM ON THE WINDOWS 7,

YOU SHOULD RUN THE "APPINST.EXE"
MANUALLY IN SAMSUNG EXTERNAL HARD
DRIVE.

THE WINDOWS 7 DOES NOT SUPPORT THE
AUTORUN FUNCTION.

Samsung SecretZone User Manual Ver 2.0
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Choose the preferred Language
The first options to choose is the preferred
language. From the Choose Setup Language
pull-down:

2. Choose the preferred language

Figure 3-3 Use the Pull-Down to choose the Language

Choose Setup Language

Select the language for the installation from
the choices below.

|English
Chinese (Simplified)
utch

English

French (Standard)
German
Italian
Korean
Portuguese (Standard)
Russian

Spanish

Install Wizard
The Samsung SecretZone Install Wizard will guide
you through the steps for installing the
SecretZone software. From the Welcome
screen:

3. Click Next>

Figure 3-4 Install Wizard will guide you through the setup

Samsung SecretZone Install Wizard @

‘Welcome to the Install Wizard for Samsung
SecretZone

The Install Wizard will install Samsung SecretZone on your
computer. To continue, click Next.

Samsung SecretZone User Manual Ver 2.0
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Installation Progress Bar
The Progress Bar indicates how far the
installation has gone and how much further it
has to finish.

Figure 3-5 Installation Progress Bar

Samsung SecretZone Install Wizand @

Setup Status
AN
Samsung SecretZone is configuring your new software installation.
Installing
C:\Program Files\Clarus\S amsung SecreZone\MSAdmin EN
NANARRRRANRRN

Samsung SecretZone User Manual Ver 2.0
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Create Password

To start using the SecretZone software, the
Administrator password must be setup. From

the Create the account for the administrator
screen:

4. Click in the box to the right of Password and enter a
password

5. Click in the box to the right of Confirm and re-enter
the same password

6. Click Next>

Figure 3-6 Creating the Administrator Password

Samsung SecretZone Install Wizard @

Create the account for the
dministrat %
administrator N

This is the account setting for the administrator to use Samsung SecretZone. Please set
the account for the administrator.

Administrator 1D: admin

Password: ~~ |eeesee

Cancel

NOTE: WHATEVER YOU CHOOSE FOR A
PASSWORD - PLEASE WRITE IT DOWN AND
KEEP IT IN A SAFE PLACE. THERE IS NO
OPTION TO RETRIEVE A PASSWORD.

Samsung SecretZone User Manual Ver 2.0
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Complete installation
Provided that the installation was successful,
the final Samsung SecretZone Install Wizard
screen appears.

7. Click Finish

Figure 3-7 Installation complete

Finished Samsung SecretZone installation

n ; The Samsung SecretZone installation finished.

O No, | will restart my computer later

Click Finish Button to finish Samsung SecretZone Installation

Samsung SecretZone User Manual Ver 2.0
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Chapter 4 Setting Up the
SecretZone
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Setting Up the SecretZone

Getting Started

In this section, examples are used to better
explore the many options available.
Now that the software has been installed, start
the SecretZone software to create virtual drives.
From the Windows Desktop:

1. Double click the SAMSUNG SECRETZONE icon

Starting the Software
Figure 4-1 Samsung SecretZone Icon
0
Samsung

Secretlone

If you do not see the Samsung SecretZone icon
on your desktop:

Click START -> PROGRAMS -> SAMSUNG ->
SAMSUNG SECRETZONE -> SAMSUNG SECRETZONE

Figure 4-2 Launch SecretZone from the Start Menu

) Help and Support

Run...

Log Off

Of %)

Shut Dawn...

¥i:| Windows XP Professional
«

Samsung SecretZone User Manual Ver 2.0
25



Setting Up the SecretZone

Logging In
The first  screen is the Login for

Administrator/User prompt. Make sure that THE
ADMINISTRATOR check box is checked.

2. Click in the Password field
3. Enter your PASSWORD
4. Click OK

Figure 4-3 Login Screen

Login for Administrator/User @

@ Please enter user ID and password

to login.
D | admin

Password ;00"“|

[JID preserve  [¥] Administrator

[ 0K ][ Cancel ]

Samsung SecretZone Main Screen

The following screen is the Samsung SecretZone

Main screen. All changes or modifications are
created from this screen.

Samsung SecretZone User Manual Ver 2.0
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Figure 4-4 Samsung SecretZone Main Screen

# Samsung SecretZone
File View Tools Help

a
Account  View

-2
Moun Mot g

Idle Timeout(Min) A pe Size Used Capacty  Status

i View Tools Help  RUCHN Tools
Titles

Tcons Changing User's Password

New Account Management. Help Contents.

Mount List Convert i
* Detais Upgrade
Refresh
Exit
[Ready UM
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Menu Choices

Along the very top of the screen is the Menu
items. The following is a description of every
menu item:

File
* New
Create a new volume image and mount volume image to
virtual drive.
* Delete

Deletes the volume image only from the entry list,
without actually deleting the volume. If you want to
delete a volume image from the entry list, it needs to be
disconnected first from the virtual drive.

* Mount
Makes the Virtual Drive visible and assigns a volume
image to virtual drive

* Dismount
Takes the Virtual Drive off so it is not accessible.

* Expand
Expands the size of a volume image. Expanding the
volume image does not affect the existing data.

* Change Password
Changes password for the selected volume image. This
does not change the login password.

* Properties
Provides all the information on volume image and
virtual drive.

* Exit

Samsung SecretZone User Manual Ver 2.0
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Exits the program
View
*Tiles
View list of the volume image or virtual drives in a tiled
format.
*lcons
View list of the volume image or virtual drives in an
icon format.
eList
View list of the volume image or virtual drives in a list
format
*Details
View list of the volume image or virtual drives a
detailed format
*Refresh
Refreshes the list the volume image or virtual drives
Tools
* Account Management

Administration’s tool for creating and modifying all
volume images and virtual drives. As well, persons with
login ID’s can modify their personal accounts.

* Change User's Password

Administration’s tool for creating and modifying all
passwords. As well, persons with login ID’s can modify
their personal passwords.

* Convert

Converts an image file (MSR) into an executable file
(EXE) or vice versa.

Samsung SecretZone User Manual Ver 2.0
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After converting an image file into an executable file,
you can use it in another system by connecting itto a
virtual drive.

* Upgrade

This option will upgrade your current volume image file
with the latest encryption. This upgrade offers an even
higher level of security for your sensitive information.

Help
*Help Contents

Click the Help menu to search for help on any Samsung
SecretZone topic.

*About
Gives you information on the revision of your software.

Samsung SecretZone User Manual Ver 2.0
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Icon Description

Just below the menu items there are icons
which perform the most often used tasks. The
descriptions are the same as the File Menu
descriptions. The only difference is that these
icons will save time. Instead of clicking File ->
Change Password, click the Change Password icon

Figure 4-5 Icons are File Menu shortcuts
# Samsung SecretZone Q@gl

File View Tools Help

& B 6 3 BE

Change Password  Refresh  New Create 1 Dismount Properties  Account  View

Drive File Idie Timeout(Min)  Access type Size Used Capacity  Status

volume. msr

B

sh  New Create Dismount Properties  Account  View
Idle Timeout(tin) Access type Used Capacity  Status
0 Minute: Read/Write 1.00 GB Less 1% Mounted,

Size:

UM

Change password of volume image UM
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The only icon that has a sub-menu is the View
icon, which has Tiles, Icons, List, Details, and
Refresh.

Figure 4-6 View Icon has sub-menu’s

# Samsung SecretZone Q@@

File View Tools Help

0T EaREA RS

Refresh  New Create  Mount T Account |

Drive File Idle Timeout(Min) Access type Size Titles v Status
Icons
List.
* Details
Refresh

Displays items in a list view. UM
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Chapter 5 Create a New
Volume Image
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Create a New Volume Image

Create New

The first thing to do is create a new Volume

Image. This Volume Image is also referred to as
a Drive.

From the Samsung SecretZone Main Screen:
1. Click New Create

Figure 5-1 Click the New Create button

& Samsung SecretZone

EEX
File View Tools Help

D EeREE RS

Refresh | Mount
Drive File

Account. View

Idle Timeout(Min)  Access type Size Used Capacity | Status

Create volume image
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This screen is to designate the size and location
of the volume. The default size is 1024
megabyte however, a volume can be created up
to the size of the Free Space displayed to the
right of the letter designation. In the following
screen, the letter designation is F.

NOTE: THE FAT32 FILE SYSTEM LIMITS THE
SIZE OF ANY FILE ON THEDRIVETO A
MAXIMUM OF 4GB. TO ENSURE RELIABLE
OPERATION UNDER FAT32, SECRETZONE
LIMITS EACH VIRTUAL DRIVE'SSIZE TO A
MAXIMUM OF 2GB. WINDOWS PC OWNERS
WHO WISH TO UTILIZE CAPACITY GREATER
THAN 2GB SHOULD REFORMAT THEIR
EXTERNAL SAMSUNG DRIVE TO NTFS IN THE
WINDOWS OPERATING SYSTEM

If the size of the volume is correct:

2. Click Browse

Figure 5-2 Create Your New Volume Image Name

Volume Image @
., Define the location and size of created
k‘ volume image.
e Size 1024 3| mMB
oA Size of volume image must be at least 35MB or
» more
V| Free space is 103932 MB
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The File Selection screen is to assign a Volume
name and file type. For the purposes of this

manual, the File Type will be the default MSR
FILE.

3. Click in the File Name box
4. Type Finances

5. Click OK
Figure 5-3 Volume Name and Type
|orive 6: v & @-
File Name  |Finances| | ok ]
File Type st file(*.msr) v‘\

If the volume name and size are correct:
6. Click Next>>

Figure 5-4 Name and Size complete

Volume Image @
- -
§ g $ o Define the location and size of created
4 volume image.
|Finances.msr

See | 1024 3 mB

Size of volume image must be at least 35MB or
more

[6: v Free space s 104955 MB

i Cancel
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Designating a Letter to your Drive

A drive letter not used by any other drive is
assigned to the new Volume.

Your local drive called the “C” drive; the *0043"
being the alpha letter designation. The drive for
this volume is the Virtual Drive and it must
have an alpha drive designation as well. In
Figure 5-5the alpha designation is G.

Your Virtual drive nhow must have a label name
and have the Idle Timeout given. In the Mount
screen:

7. Click in the Label box and enter a name

8. Click in Idle Timeout and choose 0 (zero)

The File System is NTFS and Access Type is
Read/Write.

9. Click Next>

Figure 5-5 Choosing the File System

r

b4 Mount volume image as a virtual drive.

i

Drive H: v [auo
File System  NTFS

Label Investments

Access type  Read/Wirite

Idle Timeout 0o = (Min)

[ <Back | News ] [ cancel |

NOTE: WITH "AUTO CONNECT" CHECKED, A
SECURE DRIVE MIGHT NOT CONNECT RIGHT
AWAY AFTER REBOOTING. NORMAL

Samsung SecretZone User Manual Ver 2.0
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OPERATION WILL RESUME IN A FEW
MINUTES AFTER A REBOOT

Samsung SecretZone User Manual Ver 2.0
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In the Create the account for the volume image
screen create the password and algorithm for
your new drive.

10. Click in the Password box and enter the password
for your new virtual drive.

11. Click in the Confirm box and retype your password.
12. Click in the Algorithm box and choose the algorithm
from the pull-down list. For the purposes of this

manual, choose AES-128.
13.Click Next >

- Idle timeout means that disconnect virtual drive
without any access during setting time.

- Auto connection means when the system boot
volume image connect as a virtual drive
automatically.

Figure 5-6 Creating the Password and Algorithm

Create the account for the volume image g]

Set password to volume image and
ﬂ decryption of this password

Password CITTYTYYYY
Confirm essesssee

‘You should enter password. Also password
has at least 5 and the most 15 characters.

Algorthm | #ES128 v

[ <Back || Nest> |[ Cancel ]
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The Result screen gives a summary of the new
Virtual Drive.

14. If you are satisfied with the information displayed,
click Finish

Figure 5-7 Results screen gives a summary

Click "Finish"* button to create new volume
iy @ ® Ps image.
\ g p c Setting results as like the following.
Name Description
Image Finances.msr
Size 1024 MB
Virtual drive E:
Auto mount Yes
Idle Timeout 0 Minute
File System NTFS
Label Finances
Algorithm AES128
[ < Back " Finish I [ Cancel J

The Creating the volume image progress bar
displays where how much of the task has
completed. ( 1GB = 1 min, 10 GB = 12 min )

Figure 5-8 Progress Bar

Creating the volume image
& ) (el ]

0% (1 GE =1 min, 10 GB =12 min )
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Upon a successfully created image, a prompt
appears.
15. Click OK

Figure 5-9 Successfully created Image prompt

Samsung SecretZone

.
\l) Image is created successfully.

The Main Screen displays the newly create
volume displaying the drives’ alpha designation.

Figure 5-10 Windows Explorer

& Samsung SecretZone B@@
File View Tools Help
~ ~ B.
sy l =
Refresh  New Create  Mount Account View
Drive File 1dle Timeout{Min) Access type Size Used Capacity  Status

E: Finances.msr 0 Minute Read/Write 1.00 GB Less 1% Mounted.

Ready UM

From this point, we can exit out of the software
and see where the new Virtual Drive is in
Windows Explorer.
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Checking the new volume from Windows Explorer
From your Windows Desktop:

15. Click Start -> Programs -> Accessories ->
Windows Explorer

From the Windows Explorer, you can now see
the new Virtual Drive.

Figure 5-11 Your Virtual Drive in Windows

% iy Computer []=1E3)
Ele Edt Vew Favortes Toos Help i
> D O search |2 Fosers | [T~
Address | i My Computer v B
Folders X Files Stored on This Computer
(2 pesktop
© ) My Documents Shared Documents | 1 Documents
& 9 My Computer ! liost
# < Local Disk (C:)
2 3
B come ) Hard Disk Drives
# @ Finances (E:) =
& S New Yolume (F:)
@ [ SAMSUNG (G1) - <
Local Disk (C:) New Volume (F:)
% [ Control Panel S S
# () Shared Documents
# ) 1's Documents
& & My Network Places ) SAMSLNG (G2}
& Recycle Bin L
Devices with Removable Storage
@ 0 Drive (09) [
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Chapter 6 Working With
Virtual Drive
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Expand

When the volume is ‘expanded’, there is more
space on the drive. From the Windows desktop:

Start your Samsung SecretZone software (See
Chapter 4 section Starting the Software)

From the Samsung SecretZone main screen:

1. Right-click on the volume:
2. Choose Expand

Figure 6-1 Expanding the Volume Image
& Samsung SecretZone g@@

File View Tools Help

E &G

Chersye Passhord | Refresh | New Creste | Mai Dianoirt: Properties | Aécourt. YW
Drive File Idle Tmeout(Min)  Access type Sice Used Capacity  Status
2 Finances. msr a 1.00 GB

Less 1% Mounted,

Dismount
Expand

Change password
Properties

Ready
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Enter the expansion amount:

3. Click in the Additional box and enter the additional
size

4. Enter your volume image Password in the Password
box '

5. Click OK

Figure 6-2 Change the volume size
Expand @
E:\ E=pand volume image.

Image Finances.msr

Size
File System NTFS

ﬂ Current [ 1024 \ ME
Addiional | 40 3] me
Total [ 1424 | me

Password

EJ Password: \ ittt

Cancel

After the progress bar is finished, your drive
will be expanded.

Figure 6-3 Progress of expansion

Expanding ...
(Ww )
3% (1 GE =1 min, 10 GB =12 min )
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If the image expanded sucessfully, the “"Image
is expanded successfully” prompt appears.
6.Click OK

Figure 6-4 A successful expansion prompt

Samsung SecretZone

.
\l) Image is expanded successfully.

Changing the Name
To keep sensitive files separated, there is the
option to create two Virtual Drives. One might
be for Home Finances and one might be for

investments. The first drive created was called
Finances.

1. Click on the Virtual Drive
2. Click Properties

Figure 6-5 Click Properties
% Samsung SecretZone Q@@
File View Tools Help

i A fa

Dismount Properties  Account  View
Drive File Idle Timeout(Min)  Access type Size
Finances.msr Read/write

Change Password  Refresh  New Create

Used Capacity  Status

Less 1%

0 Minute

1,39 GB Mounted,

Ready UM

3. Click the File System tab
4. Enter HomeFinances Label box
5. Click OK
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Figure 6-6 Changing the name of a Volume

Labet ‘

ra
S“— Virtual Drive: E:
File System: NTFS

Status: Mounted.
M Used space 8105984 bytes  7.73MB
B Free Space 1.485,017,088 bytes  1.38 GB

Capacity 1493123072 bytes 1.39GB

[ ok || cance |[ sppw |
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Create a New Volume

Now that HomeFinance has been created, the
next step is create the volume for Investments.
From the Samsung SecretZone Main menu:

1. Click New Create

Figure 6-7 Create the Investments image

# Samsung SecretZone Q@@

File View Tools Help
I n =
."
Dismount Properties  Account  View

Change Password  Refresh  New Create

Drive File [ew create fyiny Access type Size Used Capacity ~ Status
Finances.msr 0 Minute Read/Write Less 1% Mounted,

Create volume image

2. Click Browse

Figure 6-8 Click Browse

Volume Image @
Ty am
L2 ’ ) o, Define the location and size of created
> volume image.
[ H Browse... ]

See | 1024 3|me

Size of volume image must be at least 35MB or
more

|G: v| Free spaceis 103532 MB

3. Enter Investments in the File Name box
4. Click OK
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Figure 6-9 Enter in the name of the new volume image

File Selection @
Drive G: v & -

9 Finances.msr

File Name Investments

File Type mst filef*.msr) v Cancel

5. Click Next>

Figure 6-10 Enter ‘Investments’ in the Label box

Volume Image @
w ™ G
o] gt © , Define the location and size of created
> volume image.
Investments. msr ‘
l, Browse...

see | 1024 3|me

Size of volume image must be at least 35MB or
more

[6: | Free spaceis 103532 MB

Cancel

Figure 6-11 Click Next to complete mounting the volume image

v s
v L.t i m Mount volume image as a virtual drive.
> —_—

Diive [H: v| Haue
File System  NTFS

Label ‘ Investments

Accesstype  Read/write

Idie Timeout | 0 | (Min)

<Back | Next> | Cancel

6. Enter the administrators password for this volume
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image.
7. Click Next >

Figure 6-12 New Password for New Volume Image

Create the account for the volume image @

s Set password to volume image and
I'I decryption of this password

\

Confim lﬁ‘

Password ‘ b

‘You should enter password. Also password
has at least 5 and the most 15 characters.

Algorithm MES;EE, 5

[ <Back || Newt> |[ Cancel ]

The final screen will give you the specifics of
your newly creaed volume image.
You are returned to the Volume Image screen.

8. Click Finish

Figure 6-13 Returned back to the

Click "Finish"" button to create new volume

w ' e Ps image.
‘-’-y # e G Setting results as like the following.

Name Description
Image Investments.msr
Size 1024 MB

WVirtual drive H:

Auto mount Yes

Idle Timeout 0 Minute
File System NTFS
Label Investments
Algorithm AES-128

[ < Back ][ Finish ]l Cancel
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The prompt "Image is created successfully”
appears. ( 1GB = 1 min, 10 GB = 12 min )
9. Click OK

Figure 6-14 Successfully created image
Samsung SecretZone

.
\!‘) Image is created successfully.

The Main Screen appears showing both new
volume images.

Figure 6-15 Both volume images

# Samsung SecretZone

EEX
Fle View Tools Help
ik -
Change Password  Refresh  NewCreate /0.0  Dismount Properties Account  View
Drive File Idie Timeout(Min)  Access type Size Used Capacity  Status
E Finances.msr 0 Minute ReadfWrite 1.39 GB Less 1% Mounted.

Investments.msr

0 Minute Read/irite

1.00 GB Less 1% Mounted.

Ready

NUM
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Change a Volume Password
At some point, you may want to change the
password on one, or more, volumes.
From the Samsung SecretZone main screen:

1. Click on the Investments volume or drive
2. Click Change Password icon

Figure 6-16 Click Change Password

i Samsung SecretZone DEx
File View Tools Help
S
2 ¥ y -
1) £f B
Refresh  New Create Ui Dismount Properties  Account View
Drive Idle Timeout(Min) ~ Access type Size Used Capacity  Status
g E: 1 0 Minute Read/Write 1.39 GB Less 1% Mounted.

0 Minute Read/Write 1.00 GB Less 1% Mounted

UM

Change password of volume image

3. In the Current field, enter the current password
4. In the New field, enter the new password
5. In the Confirm field, re-enter the new password

6. Click OK

Figure 6-17 Changing the Password of volume image

Change Password @

n Change password of volume image.

Cu"ent ‘}......... i
New ‘.ooooo ‘
Confirm ‘“““ ‘

I oK ][ Cancel ]
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Adding Users

Others may also use your Samsung External
Hard Disk Drive while keeping your information
confidential.

We will create an account for John.
From the Samsung SecretZone main menu:

1. Click the Account icon

Figure 6-18 Creating a new User

7 Samsung SecretZone [(=E3]
File View Tools Help
B — n |
~ : | .
afafi Al
Change Password  Refresh  New Create Dismount Properties | View
Drive. File Ide Timeout(Min)  Access type Size Used Capacity ~ Status
E: Finances.msr 0 Minute Read/Write 1.39 GB Less 1% Mounted.
E H: Investments.msr 0 Minute Read/Write 1.00 GB Less 1% Mounted.

| Administrator Window For User Setting

2. Click Add
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Figure 6-19 Click Add to start adding a new account

Create the account for a user @

F—ﬁ Add or delete user account.

D Description
2 admin Add or delete user account.

Cancel

Samsung SecretZone User Manual Ver 2.0
54



Working With Virtual Drive

3. In the ID field, enter the name
4. In the Password, enter the password
5. In the Confirm field, reenter the password

6. In the Description field, enter the new users’ role i.e.
Accountant, Investment Manager, etc.

7. Click OK

Figure 6-20 New user and password addition

Add User’s Account @

E Add new user account

ID o \
Password \ esccee ‘
Confirm ‘ sssese ‘

Description | &ccountany ‘

’ oK ][ Cancel ]

8. Click Close to return to the main menu

Create the account for a user @

’—ﬁ Add or delete user account.

ID Description
x Jo Accountant
& admin Add or delete user account.

Add ][ Delete “ Cancel |
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Deleting Users

Just as quickly as a user was created, a user
can be deleted.

Instead of clicking Add, click to highlight the
name and choose DELETE.

. From the main menu:
. Click Account

. Click to highlight the account to delete
. Click Delete

A WDN PR

Figure 6-21 Deleting a User

Create the account for a user E]

F\ﬁ Add or delete user account.
ID Description
A e
& admin Add or delete user account.
[ Add ] [ Delete ” Cancel

5.Click Yes

Figure 6-22 Confirm User Deletion

Samsung SecretZone

\?/ Are you sure?
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Dismounting a Virtual Drive

Before disconnecting your Samsung External
Hard Disk Drive from the computer, you should
always dismount the volumes.

From the Samsung SecretZone main menu:

1. Right click the volume to dismount
2. Choose Dismount

Figure 6-23 Dismounting a Volume

% Samsung SecretZone Q@@

File View Tools Help

Refresh  New Create  Mount

D File Idle Timeout(Min)  Access type Size Used Capacity  Status
Qe Finances st 0 Minute Read/Write 1.39GB Less 1% Mounted.

Ready

NOTE: ATTEMPTING TO "DISCONNECT"
IMMEDIATELY AFTER COPYING/SAVING A
LARGE FILE OR MULTIPLEFILESTO A
SECURE DRIVE CAN LEAD TO AN ERROR.
WAIT 30 TO 60 SECONDS BEFORE
DISCONNECTING A SECURE DRIVE
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Mounting a Volume Image to a Virtual Drive
When the Samsung External Hard Disk Drive is
restarted, the drive(s) must be remounted.
From the Samsung SecretZone main menu:

. Click to highlight the drive to mount
. Click the Mount icon

. Enter the password

. Click OK

Figure 6-24 Mount a drive

# Samsung SecretZone

File View Tools Help
o Ed B

A OWDN P

Refresh  New Create  Mount Account  View
Drive File Idke Timeout(Min)  Access type Size Used Capacity
Qe Finances.ms 0 Minute Read]rite 1.39GB Less 1%

Investments.msr 0 Minute Read]rite

Login for Yolume Image @

F Mount the created volume image as a virtual dive.
Image f\nveszmems.m. |[Browse
Mount
Ready p Dive H v| Mo
R getimeon | 0 2] iy
pccess e [Foodwie @]

Password

I Pessword |00 |
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Deleting a Volume Image

If a volume is no longer needed, the volume
can be deleted.

1. Dismount the volume (see Chapter 6 section
Dismounting a Virtual Drive)

2. Right-click on the volume to delete
3. Click Delete

Figure 6-25 Deleting a Volume

File View Tools Help

Refresh ~ New Create  Mount Account View

Drive File Idle Timeout(Min)  Access type Size Used Capaci:

Qe Finances.msr 0 Minute Readjwrite 1.39GB Less 1%
Investments.msr pediiis 1.00 G8

Mount

Properties

Samsung SecretZone

Ready

g/ Do you want to delete item?

=

This will delete the volume image only from the
entry list, without deleting it actually. If you
want to delete a volume image from the entry
list, it must be disconnected first from the
virtual drive.
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Chapter 7 Creating an
Executable Image
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Converting a Volume

You can convert your secured data into an
executable file that you can take from one
Samsung External drive to another Samsung
External Hard Disk Drive.

NOTE: WHEN YOU CONVERT A VOLUME
IMAGE (.MSR) INTO AN AUTO-EXECUTABLE
FILE (.EXE) IN THE FAT32, THERE ISA 2 GB
LIMIT THAT WILL INCLUDE AN EXECUTABLE
FILE AND AN IMAGE FILE (.MED)

1. Click on the volume that you will take with you

2. Dismount the Virtual Drive (See Chapter 6 Dismounting
a Virtual Drive)

3. Click Tools
4. Click Convert

Figure 7-1 Converting an Image
% Samsung SecretZone
File View BEESN Help

Conver! t MSR file to executable file.

NOTE: THIS OPTION IS ONLY AVAILABLE
FOR SAMSUNG EXTERNAL HARD DISK
DRIVES.
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From the Conversion screen:

5. Click the Option pull-down window and choose
Executive and image file

6. Click the BROWSE

Figure 7-2 Start the selections for your conversion

Conversion @

Convert volume image to executive file or

h: 0, datafile.
o

Conversion

(%) MSR file to executive

Source
e [

Target

l ‘ Browse

Option E zoutive file) v|

Ezcutive file
il Excule and image file

I 0K ][ Cancel ]
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7. Choose the Samsung External Drive to save the
secured image onto

8. Enter the name for your secured image. For the
purposes of this manual, we named the file
Securedimage.

9. Click Open

Open @

Look in: | £ SamsungSoftware O 2 E-

\(Z)Documentation

E Appinst.exe

A AutoBackupSetup.exe
ﬂ SecretZoneSetup.exe

File name: Securedimage]
Files of type: | Executable file (% exe) v
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10. Click OK

Figure 7-3 Name and Save your converted file

Conversion @

| Convert volume image to executive file or
0y data file.
=
Conversion

(%) MSR file to executive

Source

Target

(G:\SamsungSoflware\Securedlmage.exe i :
L J
Option Executive and iﬁ':age file v]

Ny er

[ OK ][ Cancel ]

When the Progress Bar has completed, your
executable file is completed.
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Launching the Image File

When you want to open the secured file on
another Samsung External Hard Disk Drive,

you can launch your image file right from
Windows Explorer.

Figure 7-4 Double click on your saved executable image from
Windows Explorer
File Edit View Favorites Tools Help

B SamsungSoftware Q@@
"

Qeek - @ [F O search |2 Foiters | [T~

Address | ) GisamsungSoftware

8w
Folders X Name See Type Date Modiied
L‘Q Desktop [C)Documentation File Folder 8/14/2009 4:28 PM
@ () My Documents B fppinst.exe 3,432KB  Application 3(9/2009 9:24 AM
= % My Computer A autoBackupSetup.exe 40,359 KB Application 8/13/2009 11:47 PM
% <o Local Disk (C:) ¥ SecretzoneSetup.exe 8,979KB  Application 8/11/2009 9:36 AM
2 coDrive (01) o securedinage oxe | S12K8  Appiication 8/14/2009 7:32 PM
® < New Yolume (F:) (=) securedimage. med 1,458,688 KB MED File 8/14/2009 7:36 PM
= B sAMSUNG (G1)
® () MyBackup

= 1 samsungSoftware
# () Documentation
# [ control Panel
# () Shared Documents
® 3 1's Documents
# & My Network Places
& Recycle Bin

Enter your Admin password to open the file.
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